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         LECS□ Series / Driver  

Safety Instructions 
 

These safety instructions are intended to prevent hazardous situations and/or equipment damage. These 
instructions indicate the level of potential hazard with the labels of “Caution,” “Warning” or “Danger.” They are all 
important notes for safety and must be followed in addition to International Standards (ISO/IEC)*1), and other safety 
regulations. 
 *1) ISO 4414: Pneumatic fluid power - General rules and safety requirements for systems and their components 
  ISO 4413: Hydraulic fluid power - General rules and safety requirements for systems and their components 
  IEC 60204-1: Safety of machinery - Electrical equipment of machines - Part 1: General requirements 
  ISO 10218-1: Robots and robotic devices - Safety requirements for industrial robots - Part 1:Robots 
  etc. 

 

 
 Danger 

Danger indicates a hazard with a high level of risk which, if not avoided, will result 
in death or serious injury. 

 
 Warning 

Warning indicates a hazard with a medium level of risk which, if not avoided, could 
result in death or serious injury. 

 
 Caution 

Caution indicates a hazard with a low level of risk which, if not avoided, could result 
in minor or moderate injury. 

 

Warning 
1. The compatibility of the product is the responsibility of the person who designs the equipment or 

decides its specifications. 
Since the product specified here is used under various operating conditions, its compatibility with specific 
equipment must be decided by the person who designs the equipment or decides its specifications based on 
necessary analysis and test results. The expected performance and safety assurance of the equipment will be 
the responsibility of the person who has determined its compatibility with the product. This person should also 
continuously review all specifications of the product referring to its latest catalog information, with a view to 
giving due consideration to any possibility of equipment failure when configuring the equipment. 

2. Only personnel with appropriate training should operate machinery and equipment. 
The product specified here may become unsafe if handled incorrectly. The assembly, operation and 
maintenance of machines or equipment including our products must be performed by an operator who is 
appropriately trained and experienced. 

3. Do not service or attempt to remove product and machinery/equipment until safety is confirmed. 
1. The inspection and maintenance of machinery/equipment should only be performed after measures to 

prevent falling or runaway of the driven objects have been confirmed. 
2. When the product is to be removed, confirm that the safety measures as mentioned above are implemented 

and the power from any appropriate source is cut, and read and understand the specific product precautions 
of all relevant products carefully. 

3. Before machinery/equipment is restarted, take measures to prevent unexpected operation and malfunction. 

4. SMC products cannot be used beyond their specifications. They are not developed, designed, and 
manufactured to be used under the following conditions or environments. Use under such 
conditions or environments is not allowed. 
1. Conditions and environments outside of the given specifications, or use outdoors or in a place exposed to 

direct sunlight. 
2. Use for nuclear power, railways, aviation, space equipment, ships, vehicles, military application, equipment 

affecting human life, body, and property, combustion equipment, entertainment equipment, emergency 
shut-off circuits, press clutches, brake circuits, safety equipment, etc., and use for applications that do not 
conform to standard specifications such as catalogs and operation manuals. 

3. Use for interlock circuits, except for use with double interlock such as installing a mechanical protection 
function in case of failure. Please periodically inspect the product to confirm that the product is operating 
properly. 

  
Note that the CAUTION level may lead to a serious consequence according to conditions. Please follow the 

instructions of both levels because they are important to personnel safety. 
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LECS□ Series / Driver 

Safety Instructions 
 
 
 

Caution 
SMC develops, designs, and manufactures products to be used for automatic control equipment, and 
provides them for peaceful use in manufacturing industries. 
Use in non-manufacturing industries is not allowed. 
Products SMC manufactures and sells cannot be used for the purpose of transactions or certification specified in 
the Measurement Act of each country.  
The new Measurement Act prohibits use of any unit other than SI units in Japan. 
 

Limited warranty and Disclaimer/Compliance Requirements 
The product used is subject to the following “Limited warranty and Disclaimer” and “Compliance Requirements”. 
Read and accept them before using the product. 
 

Limited warranty and Disclaimer 
1. The warranty period of the product is 1 year in service or 1.5 years after the product is delivered, whichever is 

first.∗2) 
Also, the product may have specified durability, running distance or replacement parts. Please consult your 
nearest sales branch. 

2. For any failure or damage reported within the warranty period which is clearly our responsibility, a replacement 
product or necessary parts will be provided. 
This limited warranty applies only to our product independently, and not to any other damage incurred due to 
the failure of the product. 

3. Prior to using SMC products, please read and understand the warranty terms and disclaimers noted in the 
specified catalog for the particular products. 

 *2) Vacuum pads are excluded from this 1 year warranty. 
A vacuum pad is a consumable part, so it is warranted for a year after it is delivered. 
Also, even within the warranty period, the wear of a product due to the use of the vacuum pad or failure due to  
the deterioration of rubber material are not covered by the limited warranty 

 

Compliance Requirements 
1. The use of SMC products with production equipment for the manufacture of weapons of mass destruction 

(WMD) or any other weapon is strictly prohibited. 
2. The exports of SMC products or technology from one country to another are governed by the relevant security 

laws and regulations of the countries involved in the transaction. Prior to the shipment of a SMC product to 
another country, assure that all local rules governing that export are known and followed. 
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Introduction 
It is recommended that the operator read the operation manual and operation manual (Simplified 
Edition) for LECS□ prior to use. 
For the handling and details of other equipment, please refer to the operation manual for used equipment. 

 

1. Parameter Configuration using Setup software (MR Configurator2TM) 
This section describes the configuration procedure for main parameters using the setup software (MR 

Configurator2TM: LEC-MRC2E). See the “LECS□ operation manual and operation manual (Simplified 

Edition)l” for parameter details. 

 

1.1 Setup software (MR Configurator2TM) 
 

 
 

*1 Setup software version 1.45X or above is required. 
*2 The setup software (MR Configurator2TM :LEC-MRC2E) must be purchased as an additional item. 
*3 The USB cable (LEC-MR-J3USB) must be purchased as an additional item. 

 

1.1.1 Installation Method 
Perform installation according to the “MR Configurator2TM instruction manual” (Manual/ib0300160*.pdf) 
contained on the setup software (MR Configurator2TM) CD-ROM. The “MR Configurator2” software will be 
added to the PC. 
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1.2 Basic driver set-up for Initial Test Drive 
 

If you turn on the power supply for the first time, refer to “LECS□ operation manual and operation manual 

(Simplified Edition)l”. 

 

1.2.1 Start up the Setup software (MR Configurator2TM) 
①  Connect the PC and LECS□ using the USB cable. 

②  Turn on the power of the LECS□. 

③  Start application “MR Configurator2”. 

 
 
 
 
 
 
 
 
 
 
 
 
Once the application starts, the screen below will be displayed. 
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1.2.2 “System Settings” 
① From “Project” menu select “New”, the “New project” window will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.2.3 Model Selection 
① The Mitsubishi Electric Corporation series will be displayed in the model selection list. Please select 

MR-JN-A if using the LECSA. 

MR-J4-A-S099(□) if using the LECSB-T. 

MR-J3-T if using the LECSC-T. 
MR-J4-B(-RJ) if using the LECSS-T. 

MR-J4-TM if using the LECSN□-T. 

 

② Please select “servo amplifier connection USB” as the communication device. 

③ Click OK. 

④ Click OK. 

 
 
 
 
 

 
 

 
① 

② 

③ 
④ 
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1.2.4 Driver ON LINE Check 
Check that the driver is enabled (ONLINE). 

 
 
Check that the “ONLINE/OFFLINE” icon is displayed “       ”. 
 
It is OFFLINE when displayed as “       ”. 
 
* For OFFLine, PC and amplifier aren’t communicating. Confirm the following points. 
   - Is amplifier's power supply turning on? 
   - Are PC and amplifier connected with the USB cable? 
    - Is the USB driver installed? 
   - Is the setting of “Port” for USB connection corresponding? 

 
1.3 Loading Parameters (Saved files) 
 

① From the “Parameter Setting” window in the setup software, select “Open”. 

② Please specify location of the file. 

③ Please select the file you wish to import parameters [.prm2]. 

④ Click “Open”. 

Parameters will be loaded. 

 
 
 
 
 
 
 
 
 
 
 
 

① 

② 

③ 

 

 

  

④ 
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1.4 Parameter writting (PC → LECS□(Driver)) 
① From the “Parameter” menu select “Parameter Setting”, the “parameter setting” window will open. 

② The explanation of the parameter item is displayed in “MR2 Help”. 
(When it is not displayed, from the “View” menu select “Docking window” – “Docking Help”.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

③ When each item of “List display” is clicked, “Parameter list” screen along each item is displayed. 
When “Basic” is selected, it is displayed as follows. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Refer to" LECS□ operation manual and operation manual (Simplified Edition)l”, for details of each 

parameter.

 
① 

 
② 

③ 
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④ Click on the "Single Axis Write" button. 

⑤ Turn the power OFFand ON again. The Parameter is then enabled. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please set the parameters for each actuator. 
Please change the parameter values according to usage. 

 
Refer to "LECS□ operation manual and operation manual (Simplified Edition)l” for details of each 

parameter and how to change method. 
 
Refer to " LECS□ Operation Manual (Simplified Edition)” for details of parameters recommended value of 

each actuator. 
 
 

⑤ 
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1.5 Saving Parameters 
 

① From the “Parameter Setting” window in the setup software, select “Save As”. 

② Please specify location to be saved. 

③ Please enter any file name. 

④ Click “Save”. 

 
   Files Saved 

.prm2 Settings files for parameters. 

 
* Note  Always upload current parameters from the driver to the software before saving. 
 (See Section 1.3 for uploading.) 

 
 
 
 
 
 
 
 
 
 
 
 
1.5.1 Read parameters from the LECSA driver  
If you read the parameters of the driver to the software, please do the “read” operation. 
 

① From the View menu bar "parameter (A)" - please click on the "parameter setting (P)". "Parameter 
Settings" screen will display. 

② Please click on the “Read". 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

① 

② 

③ 

 

  

④ 

 

② 
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1.6 Help Function 
By selecting “MR Configurator2 Help” in “Help” from any window of the setup software, a “HELP” screen will be 
shown. 
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